


B o3 33 (6,15 s ool g Loy o

A ol € RY B R AR

I\ olf.,\g..b ).b 6).»)[5 p...m.a...u g_)Lo.Ja,S 9 .Ia.s‘;w (SN PL

VWAY oo g 0 JOUSTIEINE
VYA ole g

&3k el )l
O oBage Sl Hl58le 5 ol 18 S ole
A C¥Se Sl ng
085yl <8 i ol gawlegil 05e> | yaiul oy ousS dups

el 85 ol 8 B, b e sl e Bro g eos 055 )le 5 &) Blete Se ol (6558 5 spiee ssole Bsi> alS (Pl SN
=l oS ez S L Ls o)1 51 cie b S JES] g (oS el T deliwlid 50 sai jaseine ool o5 50 (5,00 50 0 I ditee oyl Sl gime

A oaiidy yai 0j5> LS rablie (cw s Kl sl b g cblbe 059> 5l )l ol Bl as distis ol pi5 0g aeles 8y el gie SIL g eSS

uls aslgs ol e 4y g8 0 Ky 5 005 H25 3 5 l38le 5 ols ) B slae 5 Alhe B> NS LAl aiiee cpl Sledsl

v www.chargoon.com



v

B o3 33 (6,15 s ool g Loy o

lho Cuw ygd
OO RORON dodde Jol yd
0) ettt naees B Bws 10 50,5 slapinew bl i
B e Jole o
D) ettt et )5 9,0
B ettt bbbttt ettt b ne et M- WORD
B ettt e ol> sl CTRLLP 51 solaul
R O Bas 65 5l
Y e O BB ol 4y by e Sladass
¥ et et TRUSTEDSI TES Connd )0 olF0y0 o yol 3433
A PDF yisles |5l cuas
A e e CSgd
ettt bbbt VORD Calizes (gloases jo Slelass
Qe et HIDDEN gl L1 ioles colandass
) e e HIDDEN sla |16 Ol cladass
V) e TEXTBOK jioles laylass
Y e et VWORD .5
Y s VORD .5 5l oolasw! j92ce
Y e eae VORD ;8 LaS 5L (s, OFFICEjl oolaul jg2ee
N F e WORD .5 yaus SO
VE s sssssssssssssssssssssssssssssessssnserr:MOZI LLAFT REFOX S g 10 1
VF s :GOOGLE CHROME 5 ;5 0 ,
YO ettt e e Sl e il SO

www.chargoon.com




Y s Sl 5ys0 0 SISO

Y e Gl Sl oyee o0 SIS O
N ettt st b bt nenenan L&:J‘j))lﬁ 9 u“'ﬁ)"ﬁgs'j u_JLo.»Ja.u 0
0

¢ www.chargoon.com



B o3 33 (6,15 s ool g Loy o

swsio Jgl 45 K3
ol s silwosly (A8 laoclBaus 4 coed Jglain (g lexe LD oF s canwgy ol obxn! Baal
Sl a8 59540 6,5 59,0 5l b o yoliie (pl Ay cienl 00l aligl HTMLS sy HTML a5eus oy )5

B9 oolatwl ailo 1y o laslewl (pl b )18

0 08303 43 (531 Glodpiimw byl i

S 0 oFass jo ;5 Word sleaz s g La )8 1500 ¢ Jle (glopiun (398 Dloradsl 45 azg5

=

.Qé;‘s‘o

Jole o -

5 Google Chrome (sla S ;5,0 L5 adlbioo A GTIE e 0,51 a5l @ a2 LXP 5009 0 @
23,5 o Sy Mozilla Firefox

208 oo Sy o] slatal g pled L)+ aaig 5 A j9aks Y eang ladeloptu o

28,5 o0 (Slstdy Jolopianns 0ol )3 §)BLu 55950 olpom 4 S Jalopiunns @

&5 5950

V) asw.s Internet Explorer e

YU 4 OY axus 3l Mozilla Firefox

YU 4 ¥ axui 3l Google Chrome o

Mac Jole g ;0 Ladd g YU & V) axus I Mac OS Safari e
YU 4 O+ aus jlOpera

YL 4 VF ass jlEdge o

MS- Word
(S90Sl 55 cwai L) MS-Word 2007 e

MS-Word 2010 e
MS-Word 2013 e

MS-Word 2016 o

&l omls 4o Word 2013 5l eolaiwl & g0 0 amy 4y FQ a5 51 Google Chrome )3 0 j0 1455

b oo 5l 6 Il ceal e BB il

5 www.chargoon.com



?

B o3 33 (6,15 s ool g Loy o

2 5z Ctrep 1 ol
Ole= pdf 51 aS G900 )8 (sl Ctrl+P alwgas Gl (LSGl pae o yiws Sl oolatnl &j90 o

4.1.._...:544 ul_’> ‘5‘).3 ul)..)lf ud}o; 05..\790 ‘JSIS))[B J)....S fa..\.c J..J\) aQ .)9.....» oolawl 6513);[3 uo).eu,..u.s

sty Sl Ctrl+P

P30 8l 09— eolaul Foxit Reader L, Adobe Acrobat wile 550 sba S 5l 09d oo sloiin
&9 ;| Content Type (5|, Tools > Options > Applications ;... | WSB LB o o olg> pdf o505

Sules Gl 1) (Acrobat Plugin L) Use Foxit Reader Plugin 4., ;5 PDF

0 o830 5128
o dz g b peizmen Sl onns S alde B olEws s )8 IRl lBle 5 50 Sl Sl I g ool sl
OSwl g Word Jol8 oLliS b 4 bgs o 05 Bd> L awy 43 ¥ a5eis 51 Google Chrome )5 )50 450

el 00l pol 8 5 g0 ol o ol

G,k 511y asb e Microsoft .Net Framework 4.0 L6 Jolis 45T L5 gt ol 6 0,18 1) s (sl
58 el ol il ;53 a3 ol ceas "0 sBaus 6,15l slasls i an S bl 0" seke

D pdy O jge cual 45 39 o0 Sy 3590 (5l Glirebdl (sl (Jg 9]0 3929 59,0 Sladsleptasn ST
= S L wanles QBRI g )l 1l 8l ot a3 edl 0" (soie 5l s )lS Sl cedi sl e
Sy 65 il ccas MRUN™ a5 same Gl b g 04 e plal 6 ssLIs"RUN" 438 s,

D pdy se

ools (ales =l JLlo 5o slo aslip U )0 T o015 pgad Gillas «s )5 Il 12l 5 a1 s

IWAREAPES

ent Tools v3.1.134.0 i

www.chargoon.com




B o3 33 (6,15 s ool g Loy o

o a8 Uil g o0 by yo Ciloghins

Trusted Sites Coomd y3 slEuyd wyoT (39933

5315 o3 U5 Sl 639 WOTd sLm bls 0,5 3l plSin 5 25 (il ploy Ginles 51 555k sl

g adls| Trusted Sites 4 olSuss

Microsoft Office

Some files contain viruses that can be harmful to your computer. It is
/_lQ important to be certain that this file is from a trustworthy source.

Do you want to open this file?
Program: Microsoft Word
Address:

http://office.chargoon.com/Applications/Automation/DocumentMana
ger/repository/dd881783-64a7-4df7-b611-c615e3224323.docx

Yes | No |

Security aib; ;o n5 peal Glae g 428 Internet Options cwwd 4 Control Panel ;1 jslaio opl gl
I, Require Server 4 by, S5 g 00,5 Sl |, Sites a8 (Trusted Sites cuwnd o SIS L

...\.as...u C)L’>- Axoo )‘ Close M; g_;l.’?u.v‘ Lv Le(\.v‘ ).) 9 cAdd ‘) alf.,\g..) u.u)\)" 9 M‘b))

Internet Options ?

| General Privacy I Content I Connections lPrograms [ Advanced |

Select a zone to view or change security settings.

@ & |/ |0

Internet  Local intranet | Trusted sites | Restricted
sites

e o
> / This zone contains websites that you

trust not to damage your computer or
your files. B
Trusted sites “

Security level for this zone

You can add and remove websites from this zone. All websites in

Allowed levels for this zone: All . this zone wil use the zone's security settings.
Medium

- Prompts before downloading potentially unsafe

content Add this website to the zone:

- Unsigned ActiveX controls will not be downloaded [ o0 41390 o oy ] | A |

Websites:
["]Enable Protected Mode (requires restarting Internet Explorer) [ ] B
Custom level... Default level

Reset all zones to default level

Bme server verification (https:) for all sites in this zone
@ Some settings are managed by your system administrator.

OK tanoelw ' Apply
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Srr ppal O9h Sy B ogd oo (b Hidden ©jsoa Sy poas l8le 5 o eslital cgz asl
=25 Gy 5l sl 55 anl sdalive sl [0 S5y s onls Hidden pgas soslice gl ol ,dy oSl

Swled Jleé |, Hidden text glaasy s

1 ss 3l Word 2007 ,o @

Office Button > Word Options > Display Tab > Hidden text

15 yews 3/ Word 2010 ,2013 5

File Menu > Options > Display Tab > Hidden text

General - . 2
RS @\ Change how document content is displayed on the screen and when printed.
| pisptay |
Proofing Page display options
Save Show white space between pages in Print Layout view
Language Show highlighter marks
e Show document tooltips on hover
Customize Ribbon IAlways show these formatting marks on the screen I
Quick Access Toolbar [] Tab characters =2
Add-Ins L] Spaces
[] Paragraph marks hll
Trust Center
|4 Hidden text abe |
[] Optional hyphens -
[] Object anchors ¥
[] Show all formatting marks
Printing options
Print drawings created in Word
[] Print background colors and images
[] Print document properties
[] Print hidden text
[] Update fields before printing
[] Update linked data before printing 20

I OK l ‘ Cancel
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55 e 5 Word 2007 ;5 @

Office Button > Word Options > Display Tab > Print Hidden text

15 saews 3/ Word 2010 ,2013 5

File Menu > Options > Display Tab > Print Hidden text

G | I .
s q Change how document content is displayed on the screen and when printed.
Display
Pronting Fage display optlons
Save Show white space between pages in Print Layout wiew (2
Language Show highlighter marks (i)
Advanced Show document tocltips on howver
Customize Ribbon Always show these formatting marks on the screen
Cuick Access Toolbar [ Tab characters —
Add-Ins [ Spaces
[ Paragraph marks T
Irust Center
Hidden text abc
[ tiphinnal hyphens -
O Objecl anchurs \Iy

Ll Show all formatting marks

I Printing options I

Prnt drawings created in Word (6]
[ Print background colurs and imayges
LI Print document properties

[] Update fields before printing

[ Update linked data before printing

I oK I | Cancel
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Q)H‘U Word uLo...LL..’ ba_msa oslw! Text box )‘ waa.\j) 9 Lol T (5‘)-’ sl ‘59i” @‘)b B
Show o35 15 slo e 5l dlayl soalin pae &g )0 amd o Sisles |, Text box (5,8 i

Swles ol |, drawings and text boxes on screen

) so 3l Word 2007 5 @

Office Button > Word Options > Advanced> Show Document Content > Show drawings
and text boxes on screen

) e 5| Word 2010 ,2013 5 @

File Menu > Options > Advanced> Show Document Content > Show drawings and text
boxes on screen

General 2
IShow document content I

Display
o [] Show background colors and images in Print Layout view

roofin,

" [[] Show text wrapped within the document window

Save [] Show picture placeholders
Language I Show drawings and text boxes on screen l
Advanced ["] Show control characters

[C] Show bookmarks

Customize Ribbon g
[C] Show text boundaries

Quick Access Toolbar [ Show crop marks
Add-Ins [T] Show field codes instead of their values
Trust Center Field shading: iWhen selected | v
Numeral: { ContextE]
Month names: }»A[qlz[c ) EI

Diacritics
[] Use this color for diacritics E/
[] Use draft font in Draft and Outline views
Nameg: ‘W
Size: ‘Ti‘
Document VIE'W‘ il
() Right-to-left
@) Left-to-right
[] Use fonts that are stored on the printer

| oK || Cancel |
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8 Most Visited @ Suggested Sites @ Getting Started @ Web Slice Gallery

i Allow hitp//eo.ipecoiorg to un "Micresoft Office’?

19 il s | 12:26PM

&2 Chargoon Didgah o+ A >
€ i) eoipecoorg Defaukaspimd=jebpespsnesuesykckpycuiyvastap @ || Q Seorch e $ A OQ =
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Allow http:/eaipecarg to run “Microsaft Office?
Leam More.
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Sl p3Y a5 walgsy Office 5,k 511 LB LS5l ojll pis Word 5l colaul ool jo conl Sow

Sl Jos p &jpen

Launch 4_y 35 9 05|, Remember my choice... S_J Google Chrome 5,500 ;0 ®

dw led wlill 1 Application

X
External Protocol Request

Google Chrome needs to launch an external application to handle ms-
word: links. The link requested is ms-word:ofe|u|http://ec.ipcco.org/
Applications/Automation/DocumentManager/repository/
4cfd0Sb7-92f7-4d1c-bf94-cccecbae33ea.docx.

The following application will be launched if you accept this request:

C\PROGRA~1\MICROS ~2\Office14\PROTOC~1.EXE “ms-word:ofe|u|http://
eo.ipcco.org/Applications/Automation/DocumentManager/repository/
4cfd05b7-92f7-4d1c-bf94-cccecbae3d3ea.docx”

If you did not initiate this request, it may represent an attempted attack on
your system. Unless you took an explicit action to initiate this request, you
should press Do Nothing.

D Remember my choice for all links of this type.

l Launch Application |] Do Nothing ’

Remember my choice for ms-word links « ;5 5 3.5 Mozilla Firefox 5,950 ;0 ®

wow bod olil 1) OK ady 35 9 00 1,

This link needs to be opened with an application.

Send to:

Microsoft Office 2013

Choose an Application

D Remember my choice for ms-word links.

[ ok || cance |
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Word 1 oLaS sl 5l 15 59,0 ( Jml 5LaS5L sl Office 5l oolatul joe o nudats pac &jse jo
mled Joo nj JS8 @ Cunlion JSie (al @) sl o wlei oo 5 S5l

:Mozilla Firefox ,5 g0 4
4o g oLzl |y Applications a5 5 sai 3illdas g ogles SIS Options 45,35 (gg, ,» Tools (g0 ;|
Use Microsoft Office ... 438 w9 S5 gad (0 odd jaseios 4l (59, » lail ms-word coad
Awles Gl | (default)

¢” Chargoon Didgah X | 3% Options x & - o IEH
€ | L Fietor aboutpreferences#applications e || Q search wE O 3 4 00 =

Applications

p
A Applications Content Type | Action
| AUUUE ACIUDEL AIL Uata Fackage e - USC AUUUE ACTOUGETT TR
< ~
& irc £ Always ask
N & ircs 2 Always ask
0 " - 1
= mailto Use Pick an app (default)
& Advance & ms-word - Use Microsoft Office 2013 (default) D
& Podcast £ Always ask
% Portable Document Format (PDF) Al B Use Microsoft Office 2013 (default)
& Video Podcast Use other.. [ Microsoft Offce 2013 |
B Web Feed ) Preview in Firefox
& webcal £ Always ask ®

:Google Chrome ,5 g0 4

Ngd sy S olod o]

So o 1) Local State Jols a8, %LOCALAPPDATA%\Google\Chrome\User Data\ s 4y e

"ms-word": false a_, |, "ms-word": true 43,5 gz |, "ms-word" & jle 5 S 5b e Kiul g
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D905 y0lo 1y ol 5l eolaiwl o3l 55 sla g,

:Motzilla Firefox ,5 ;90 y0

J ‘5 Chargoon Didgah x \+ - |
€ 1@1 office.chargoon.com/Default. aspmd=Inevcemohimbglwwtyabiltajtpkrays @ |[Q siweh 4B O 8 AOO =

Allow http://office.chargoon.com to run *Dynamic Web

2

Allow Now l Allow and Remember

TWAIN"? Learn More.

:Google Chrome ,5 g0 ,o

5 e Lol s Sl o (g5 o s oo s 5L Sl Jos alowil (sl oFR 51 5YL sloasens o

iboe 6900 0 B )8 Il og Jbd

:0 655505 J> ol Sglsls 6y hui o )JIS.O
O3 aS sl 1 i )T 500 Jlas] sl b lacangy cdl 0 plne wlfays 1 eslatul gl jo a5 G900

Saled Ll 55 pgal 10 ead (astie slaan S wah axlye Hais ;g0 L

:Mozilla Firefox ,5 g0 yo

t | Release - (niulojl asuui - Ch...

.chargoon.net/Default.aspx?rd=hcbemvdjbbeimgiebiubdfova + C | | [~ Google Pl B $ A

[@ Firefox prevented this site from opening a pop-up window.

Allow pop-ups for release.didgahs.chargoon.net

Edit Pop-up Blocker Options...
Don't show this message when pop-ups are blocked

sh5.chargoon.net/Default.aspx?rnd=ctredhmtigrmnjypeqgpphklhurfkdsal

The following pop-ups were blocked on this page:

hitp://release.didgah5.chargoon.net/Appl...236565772467946656¢572b&forceDownload=1

|/ Atways allow pop-ups from release.didgahs.chargoon.net |

Tontinue blocking pop-ups —=

e Manage pop-up blocking. Done | l

o ) (et ) oo ) [(Seaumior) [ oums ) [zt sisaaarmizst ] [ ems | [gont ) N
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=l b e System Tray jo o 66T clls pl jo canl izl Jl 30 605 Il 4 agds iadae @
g g0 03ld iled

23S Jadyed Cdse jsb s |y o Jlg e b (mg sl 02g Sy 0 @

a5 59,8 Jbd,e uien gInternet Option o ool cow sla Proxy sled 0,5 Jld, e o

(SlaSih gy oSy sleolainl O g0 o QT oo, Jbsé b g Automatically Detect Settings

General Security Privacy Content Connections programs  Advanced

To set up an Internet connection, dick Setup
Setup.
Local Area Metwork (LAN) Settings x
Add...
Automatic configuration
Automatic configuration may override manual settings. To ensure the Add VPN...
use of manual settings, disable automatic configuration,
| Automatically detect settings | Remaove...
|:| Use automatic configuration script Settings
Address
Proxy server
0 Use a proxy server for your LAN (These settings will not apply to [
dial-up or VPN connections).
Address; Fart: | 80 Advanced
|
Bypass proxy server for local addresses
LAN settings
Cancel
oK Cancel Apply

Office a5 wpled oy 990 sod Jlosl jgpw ;0 0,53 51 s Word L1 &l 55 oS 90,0 @

Ao led oolazwl Resume Uploads asSs 5l (gl &y ;o tadly ouis cadsie Upload Center
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Manage Microsoft Office file uploads to web servers

|Name | Status ~

- 0

% 6bcb7870-b0fd-4a91-b6a6-065891fbb&0c.docx ‘ I Upload Paused "Act' m
=| http://office.chargoon.com/...ntManager/repository/ Last saved todayft 12:39 PM e

X

Upload Center 0] Office
Actions ¥ %] Upload All 3£ Settings £ Refresh  Pending Uploads ¥ 85 v 2

P8l 0590 50 (FIS

s5bany ey Glaasnd &5 (50,0 S eal 5 00,8 il |y )5 !l At B
.S Uninstall ciws &, 504 Programs And Features 3 )b 5l 1) lag,T ciois Bds Sags
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S Jld et CBg0 psbo |y T gl b Gog s sl 0979 90 50

el )3 MS Paint asile Lo 38l 5l 5o 51 528,55l lSel 45 aygb yiakas

S5 Il Sy90 5o SIS

An attempt was made to access a socket in a way forbidden by its access permissions : gll> oly

Saze g 03,5 Stop |, )] ,Lb S World Wide Web Publishing Service ;o4 Jled g1IS 5425 & g0 j0

sl Ll 1 6,8l
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